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CHAPTER 2

IMPLEMENTING PROFESSIONAL
DESIGN PRINCIPLES

I could try to convince you that I deliberately kept the figures in Chapter 1,
“Planning an Effective Presentation,” ugly, but I doubt you'd be fooled.
What I did do, however, was to keep them as simple as possible leading
into this second chapter.

For a verbal person like me, what professional designers do is almost
like voodoo—they seem to follow some sort of arcane process, and at some
point, they transform the ordinary and ugly into something that is astonish-
ing in its clarity and beauty.

If you've sat through a lot of PowerPoint presentations, and most of us
have, you've undoubtedly been struck at rare intervals by the thought that
“This doesn’t look like PowerPoint.”

Frequently, this is not the result of some dramatic new template or
look for the presentation.

In fact, it is almost certainly the result of the absence of an intrusive
look or design.

The word that most frequently crosses my mind when I have this expe-
rience is “clean.” Like many presenters, I strive for a clean and clear design
for any presentation that I create, but invariably I fall short of what I per-
ceive to be the unmistakable clarity of something designed by a profes-
sional.

The quintessence of this level is epitomized, in my estimation, by two
regular contributors to Presentations Magazine and participants in the
PowerPoint LIVE show: Nancy Duarte and Julie Terberg.

Both have carved out a special niche in the world of presentations by
mastering the medium of PowerPoint both technically and artistically and
by marshalling their own skills along with those of teams of designers to
create visually effective presentations.

Again, what both of their samples share is a simplicity.
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Nancy’s and Julie’s respective styles are quite different. I would
describe the Terberg method as more colorful and dramatic, while Duarte
Design is more corporate and understated. This probably results at least in
part from their main clientele; Julie Terberg has written an entire book on
doing medical presentations, while Nancy Duarte has created templates
and collateral material for some of the worlds leading corporations that
reflect their brand identity.

Before we even begin to cover a few techniques and processes to
attempt to emulate the clean and crisp look of a professionally designed
presentation, I encourage you to look at the portfolio samples at Nancy’s
and Julie’s websites:

= http://www.duarte.com
= http://www.terbergdesign.com

What Designers Think About

One of the things that separates professional designers from other people
is that they can spend hours and days talking about things like fonts and
colors. On the other hand, I am a guy who has used sets of Polaroids from
a tailor to dress himself in an outfit of matching slacks, jacket, shirt, and tie.

Can the basic principles of sound design be learned and applied by
everyone?

I believe that as a presenter, you would accept this premise at your own
peril. You are much better served by using the guidelines and taking advan-
tage of the expertise of someone skilled in the design field.

Even Microsoft doesn’t believe it—that’s why each version of Power-
Point has been released with its own Design Templates that strive to make
the implementation of a well-crafted design a no-brainer.

The results have been at best mixed. On one hand, applying a com-
plete Design Template gives your presentation a blended look, along with
complementary colors and fonts that seem to work well together...up to a
point.

As we'll see, applying a packaged design can greatly streamline the
design process, but it comes at a price. Although it does address a key
issue—after you have chosen a complete look for your presentation, you
can get on with the work of creating your content—it may not be the
answer for presenters who want to truly stand out from the pack, represent
a unique identity, or communicate a message using the subtleties of color,
space, and professional design.
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Let’s examine the PowerPoint Design Templates more closely before
we look more deeply into proven design principles and apply them to our
own work.

‘T

Using the PowerPoint Design Templates

If we return to the basic Rational Real Estate presentation we worked with
in the previous chapter, we see that it has had no design template applied
to it.

Notice that the Design Templates that are in use in the current pres-
entation are at the top of the Slide Design—Design Templates Task Pane,
and more recently used designs (if you've been working for a while) are in
the panel directly below (see Figure 2-1).
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FIGURE 2-1  The Slide Designs in the Slide Design Task Pane are divided into those currently
in use, the ones most recently used, and other design templates available in PowerPoint.
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We can scroll through the available designs and apply one instantly by
clicking on it, and it becomes the template for the entire presentation.

We can also click the drop-down arrow at the right of the design tem-
plate thumbnail and get other choices, including Apply to Selected
Slides—in this case, that would be the one in the preview window in Nor-
mal view (see Figure 2-2).

[ Microsoft PowerPoint - [Rational Real Estate-bumpers.ppt] S EIEY
{EE) Fle Edit View Insert Format Tools SldeShow Window PFCMedia Help Bresze amow Duplcate Side shadow2 Type a guestion forhelp  + X
iTmestienronan - 24 | B 7 U s [E]E B2 A &S] A - wosm Snesie [
R PEIR B0 S H 3B IR P K LRS- @E e -lef
‘, [w] X R R SRR RS R RN SRR RS EE RN RN FERN EERS CE RN ERRY R 3 [RRRE ST  slide Design - x
51 = Slel| &linil
¢ [l — . &) Design Templates
* H [z} Color Schemes
s M [ Animation Schemes
2 : Apply a design template:
. [ :
o == :
- %ﬂ : Valley Vistais | OQur Residents Love
& — | Nearly Sold Out the Community
A4 | e |
= B
5 B .
- You Can Move in | Why You Should
: Right Now Act Now
6 :
E=l= &
== : ; ;
7 | T o = -
T
B ]
t ot
= gl |-
Click to add notes Apply to All Slides
5 [ 2oply to Selected Sides -
: Es== 4l I3 ] : Use for All New Presentations
fopw-[5] amsteres- N N ODOEH A EE |- L-A-==50 3] ——————
Show Large Previews
Side 20f 12 blank (25

FiGure 2-2  Clicking the drop-down arrow in the slide thumbnail of the Slide Design gives
us the option to apply it to only the current or selected slide.

NOTE This technique works with the slide thumbnails in Slide Sorter view by

allowing you to apply a design to a set of individual slides that you select using
the CTRL+click method.

If we apply the design to the selected (or currently viewed) slide here,
the effect is dramatic. Not only is a design applied to the slide’s back-
ground, but complementary colors for lines and fonts also replace those
that were in the slide before the template was applied (see Figure 2-3).
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FIGURe 2-3  Applying a Slide Design from the Gallery changes the colors of lines and fonts
to coordinate with the overall design.

In addition, if you scroll back up to the top of the Gallery, you see that
the new design has joined the basic design as those that are in current use
within the presentation.

NOTE We applied the new design to one of the slides other than the Title Slide.
The Design Templates generally have a slightly modified design for the Title Slide
to set it apart. However, it is the slide design for all other slides that is shown in
the preview slide design thumbnail.

So the good news with slide designs is that they quickly and efficiently
convert one or more slides into color-coordinated packages, complete with
common design elements in the background.

The bad news is that these packaged designs generally brand your
presentation as just another PowerPoint slide show, and everyone has seen
most of these designs a million times.
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If you click the Browse button at the bottom of the Slide Design Task
Pane, you can open the file folders for the various design templates
(including those from previous versions of PowerPoint from which you
may have upgraded) and find and preview even more packaged slide
designs (see Figure 2-4).
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FiGure 2-4

Using the Browse button to open your actual template file folders provides an

even greater selection of pre-packaged PowerPoint templates.

If you click on Design Templates on Microsoft Office Online (see
Figure 2-5), you can download yet more packaged designs from the
Office Assistance website (http://office.microsoft.com/en-us/templates/
CT011153611033.aSpX).

If you find a Design Template that suits the flavor of the presentation
you are creating, then using the slide designs makes proceeding with your
presentation a snap. The colors you have applied complement each other,
and even if you add drawing objects, the lines and fills (or accents) will con-
tinue to be complementary according to the slide design’s Color Scheme,
which we will cover more extensively in a bit.
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FIGURE 2-5 There are always new categorized templates available for download from the
Microsoft Office Assistance center.

But my guess is that after you have familiarized yourself with some of
the examples of corporate designs that are clean and reflect a corporate
brand, you will want to learn how to create a set of more professional tem-
plates for your own presentations.

Creating a Branded Template

I have seen Nancy Duarte, a well-established expert in the area of presen-
tation design, speak at a number of conferences, hoping that her skills will
rub off on me and I will no longer need Polaroids to decide what to wear
for an evening out.

She has broken the design process for templates into a number of dis-
tinct areas and provided some valuable guidelines for constructing a
branded corporate template. What is striking about her final results is how
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clean they are and how different they look from anything in the Slide
Design Task Pane.

Nancy’s company, Duarte Design, creates a set of templates for its cor-
porate clients that they can use for the main presentation types within the
corporation:

= Overall Corporate Template—Has a long lifespan, adheres to
the tight guidelines imposed by the brand, and is used throughout
the company.

= External Templates—Used by verticals within the company for
their own marketing, sales, or other endeavors. This can deviate
from the main corporate template to the extent that the branch has
its own identity.

= Events Template—Used externally for limited uses, such as a
trade show or presentation. This may be controlled more by the
artist and might map to an event or theme.

= Internal or Program Template—Used within the company for
campaigns and may be updated for specific projects. Can have a
short lifespan and may be confidential.

This gives you an idea of the scope of creating a set of templates for a
corporation from a professional perspective. Depending upon the size and
parameters of your own presentations, you may or may not want to create
separate templates for these various applications.

But if you want to create presentations with a clear sense of identity
relating back to you who you are and what you represent, you may want to
continue down this path and think through some specific decisions.

Don’t Fear Space

One of the first things that strikes you about a Duarte slide is how easy it is
to read and absorb. There is no competition for attention among disparate
design elements; even a logo, when present, is unobtrusive and subtle in its
effect.

There are no extraneous clouds, dissolving lines, squiggles, curls, or
blobs coming at you along with the material. Yet the slides are not bland. In
many cases the colors are vibrant, and they are subdued where appropri-
ate, and sometimes you ask yourself why anyone would pay for something
so seemingly simple.

This relates directly back to the underlying design choices made about
the original template—or blueprint for the presentation.
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Analyzing Collateral Materials

If you are creating a presentation for a corporate client or work directly
within a large company, you need to focus upon the design decisions that
have already been made to promote its corporate image or brand. Duarte
calls this auditing or studying the visual attributes of the brand.

A great way to do this is to analyze the website of the company and do
a thorough review of their collateral materials. Obviously, the design and
positioning of the logo is a key component to any design that may be used
in presentations. In addition, the choice of colors and how they are used
can best be gleaned by looking at a variety of web pages, reviewing
brochures, and even taking a long hard look at business cards.

If you take a look at Google.com, you immediately see the simplicity of
the overall look and the unmistakable color choices reflected in the letters
comprising the corporate name.

Whether you've ever realized it or not, Hewlett-Packard has a certain
shade of purple or dark blue associated with its main logo. An entirely dif-
ferent shade of blue represents American Express. These attributes are
immediately obvious to a designer. For those who are not specialists in this
field, the use of color and the layout of a page or brochure may become
apparent only after time or, in some cases, never.

In Chapter 1, we added some images to a slide for our imaginary real
estate presentation (refer to Figure 1-7). Let’s pretend that this image rep-
resents our corporate logo and use it to illustrate some of the steps involved
in creating a simple branded template.
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Using a Grid System

Duarte uses a simple spatial grid concept to create a template that is in her
words “a container for amazing content.” The best way to see how her grid
concept emphasizes simplicity is to contrast it to the PowerPoint Layouts
in the Slide Layout Task Pane or the numerous placeholders that scream to
be filled in within the Slide Master view.

In a new, blank presentation, whenever you open a new slide, the
default layout is Title and Bullets, and the Slide Layout Task Pane pops up
(see Figure 2-6).

If you switch to the Slide Master view, which represents the true blue-
print for all formatting for the design template (as we’ll cover in more
detail later), you get an even more complex set of placeholders crying out
for fulfillment (see Figure 2-7).
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FIGURE 2-6  PowerPoint prompts you to create a bullet slide or choose another layout, most

of which have placeholders for content.
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also features placeholders for lots of text to be formatted.
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Contrast this with the type of slide a designer like Duarte may create,
which really springs from one of the simplest Slide Layouts in the Task
Pane: Title only.

For a simple corporate template, she may add only a single thick line in
a color coordinated with or central to the corporate logo. Or, she may posi-
tion the logo beside the slide title.

You can either use the View > Grids and Guides feature directly within
PowerPoint or create your own mini-grid system with a table or the Draw-
ing toolbar to further refine the use of space within the template slide.

If you like, you can then Reapply the Title and Bullet Layout and repo-
sition and format the bullets within the grid. Figure 2-8 shows the result.
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FIGURE 2-8  You can create your own identity template from a Title only slide by using @
grid system.

Duarte’s team builds the various types of slides that her corporate
clients may use by continuing to

= Position text with white space within a grid system

= Create vertical and horizontal anchor points
= Use corporate branding elements
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NOTE The slide being created here is for initial design purposes only; to actually
implement this design throughout the entire presentation, the design choices
made in this phase need to be used in a series of Masters, which can then be
applied to a set of slides with content—as we'll see in section, “Understanding
the Role of Masters.”

Positioning a Logo

The logo’s position directly under the simple line or bar is just one possible
choice.

As we can see in Figure 2-9, there are at least four other positions
where the logo could be located that keep it clear of the main content

areas.
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FIGURE 2-9  Using a cleaner look and the grid layout, you have other positioning options
for the logo.

Using either the multiple Masters feature of PowerPoint (or by saving
any of these logo locations as a separate Design Template), you could cre-
ate an entirely different “look” within your branded sales presentation or

o
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create a different look for a marketing plan, a training session, or any other
application or presentation type you may need to create.

To create multiple Masters, you would simply return to Slide Master
view, click create New Master on the Slide Master view toolbar, and
reposition the logo in the four new locations for each new master (see
Figure 2-10).
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FIGURE 2-10  Four newly created Masters appear at the top of the Slide Design gallery in
the Slide Design Task Pane.

Using a Branded Color Scheme

So far, we've only used the eight basic colors of the blank (white back-
ground) slides with which we’ve started. We can see a very basic and bland
Color Scheme if we click the Edit Color Schemes prompt at the bottom of
the Color Schemes part of the Slide Design Task Pane.

If we click the Custom tab within Edit Color Scheme, we can create
our own Color Scheme composed of entirely different colors, as shown in
Figure 2-11.

But what colors would we choose, and why are they important?

o
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FiGure 2-11

The Custom tab in the Edit Color Scheme dialog box allows us to set default

colors for all of the slide elements in our template.

The ones here seem to complement the logo we are using, but lets
examine it more closely.

To truly create our own branded set of slides, we will want to integrate
the colors of the logo more completely with the Color Scheme of the pres-
entation template.

WHEN TO USE A BACKGROUND The Background formatting tool in Power-
Point is a vestige of a time before templates and Masters, particularly when
35mm slides were still in vogue. It doesn't affect the overall template or Color
Scheme when the Background is applied, so it doesn’t have much power. What it
is good for mainly is to create a conventional two-color gradient of the type that
used to be the standard for 35mm slides.
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Fine-Tuning Color Schemes

If we type the word “Title” for our new slide in our design presentation and
select it to format it with the Font color tool, as shown in Figure 2-12, we
see a set of eight color swatches to choose from directly in the Font color
tool, along with a choice for More Colors.
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FIGURE 2-12  The Font color tool dialog box shows the eight basic color swatches that are
currently set in the slide’s Color Scheme.

The default Title text color right now is the darker blue, but we could
be sure that if we left this color for a corporate template, someone some-
where would say something like, “That’s not exactly the shade of blue we
use in our logo!”

We could use these swatches to try to match it visually, but it would
apply only to this one slide, and even then, it wouldn’t truly be exact.

But for our corporate template, we want to make sure that the major
elements in our slide are covered by the Color Scheme:
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= Background

= Text and lines

= Shadows

= Title text

] FiHS

= Accent

= Accent and hyperlink

= Accent and followed hyperlink

All of these elements will follow the specified set of colors that we
select so that all the color choices in our slide will be uniform going for-
ward. So how do we determine these colors with complete precision?

The secret is in the RGB values, or the numerical values assigned to
the shade of red, green, and blue in any color. Unfortunately, PowerPoint
has no color picker or eyedropper tool that lets us suck a color out of an
image (like our logo) and make sure that this precise color is what we’ll be
using for Title text in our template.

We need to go outside of PowerPoint for the first time; we’ll use Adobe
PhotoShop, but any good image editor will let you determine the RGB
value of a specific color.

In Figure 2-13, we click the eyedropper over part of the logo’s roof in
PhotoShop (or the trim below the roof), and that color becomes the Back-
ground color for the PhotoShop composition.

More important, in the Color tab of the Color palette, the RGB values
are available:

= R—9
= G—54
= B—119

Now you're in business. When you return to the Edit Color Scheme
dialog box for our Custom Color Scheme (refer to Figure 2-11), you click
on Title text to select it, click on Change Color, and go to the Custom tab in
the Title Text Color dialog box, as shown in Figure 2-14.

Now, by entering those RGB values from the logo’s trim color into the
settings, you will exactly match the color in the logo for the default color
for all of your Title text in the new custom Color Scheme.
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RGB value of a specific color in your logo or other part of your collateral material.
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that color to any of the elements in your Custom Color Scheme.
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NOTE RGB is not the only numerical representation of a color value. There is
also an HSB (Hue, Saturation, Brightness) value, which defines a specific color in
terms of these three variables. And for the web, the HEX color values define spe-
cific colors for display in web browsers according to HTML code. Any of these
could be used to finetune a logo as described here.

We’re almost done. Now when we click Apply and OK to close out, the
new Custom Color Scheme has taken its place at the bottom of the Slide
Design—Color Schemes Task Pane.

We can switch to Slide Sorter view to see all of the slides in our new
template, click on the drop-down arrow in the new Color Scheme, and
choose Apply to All Slides, as shown in Figure 2-15.
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FIGURE 2-15  Applying your new Custom Color Scheme to all slides ensures that all
elements in the subsequent slides based on that Design Template have the same color
attributes.
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In this case, all we've done is apply a slightly different shade of dark
blue for the title. To see more dramatic results, apply any other Color
Scheme, but remember to Undo (CTRL+Z) after you see the results.

A professional designer would then assign other colors from the collat-
eral material or logo to the specific elements in the slide that should reflect
them. This would create complementary colors for fills, lines, and other
text.

WHAT’'S AN ACCENT? Accents are similar fo line colors and would change
the main solid block line above the Title text in this template and also the bound-
ary line that highlights the grid.

So now lets imagine that we’ve matched our colors exactly, assigned
them within our Custom Color Scheme according to their RGB values,
and applied the Color Scheme to our newly created Design Template.

What we've accomplished is to simulate the process of a professional
designer in matching the characteristics of a nice clean template that is not
based on any of the PowerPoint templates in the Slide Design gallery.
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AVOIDING SURPRISES: ANTI-COLOR SCHEME STRATEGY There are
situations where you want to create unique slides within a presentation that will
not conform to a Color Scheme or match your template and, more importantly,
will not change the colors in their elements even if they are moved to other pre-
sentations. Many users have had this happen—they design a great chart or dic-
gram, but when it is moved, suddenly the colors change.

The Color Scheme basic eight colors are the key to this issue. Whenever you
use the basic eight Color Scheme colors for any element (as shown in Figure 2-
12), those colors are subject to change if they find themselves in another presen-
tation ruled by another template with its own Color Schemes.

How can you avoid this problem?

Choose the More Colors setting for any of these elements and then choose
other colors for lines, fills, text, or any other items that you don’t want changed
no matter what.

If you still need to use complementary colors, choose the corresponding
swatches under More Colors that match those in the basic eight. To make this a
bit easier, whenever you select More Colors and choose a Custom color, it will
appear as the ninth, tenth, or successive color in your color swatches under
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dialog boxes like Text or Fill color. By creating a second row of More Colors that
correspond to the basic eight (using the RGB values again), you can get the best
of both worlds—match the Color Scheme of your template and make sure nothing
happens to the colors if the slide finds itself in another presentation down the
road.

NOTE The Goddess of Color Schemes is PowerPoint MVP Echo Swinford. Her
tutorials and excellent advice can be accessed online at
http://www.echosvoice.com.

Saving Your Design Templates

The only thing left to do is to save our new design as a new template.

If we were doing a major project, we might very well save subtly (or
perhaps even dramatically) different versions of this color-coordinated
template for each of the template types for our corporation—one set for
corporate messages, another for special events, one for in-house training,
and so on.

If you were creating this template for a corporate client, you might
want to save all of these template files in a special folder, which you would
deliver upon completion.

But if you are using these templates internally or for yourself, there are
some important things to consider.

First of all, template files are not ordinary PowerPoint files. When we
save the Design Template file, we need to click Save As and then change
the Save as Type setting from an ordinary *.PPT PowerPoint file to a
* POT template file, as shown in Figure 2-16.

Now, when you do this, by default, you will notice that the destination
folder changes to your Templates folder.

For most users, simply adding it to the default Templates folder is
enough. But because your templates will become quite valuable if you
design them for specific uses or take this much time and trouble to fine-
tune them, you will want to know where they’re located so that you can
protect them and back them up.

If you were to search for the file design.pot, you would find it in a spe-
cific Templates folder under your User Name in Windows XP, as shown in
Figure 2-17.
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In my case, this is the folder name: C:\Documents and Settings\
Professor\Application Data\Microsoft\Templates, where Professor is my
User Name. Your location would be based on your User Name.

Then, to locate a specifically named template for reuse, you would
think that in a new presentation it would automatically appear in your
Recently Used panel in Slide Designs.

It doesn't.

You need to click the Browse button at the bottom of the Slide
Design Task Pane and locate the newly saved folder by name, as shown in
Figure 2-18.
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FIGURE 2-18  The newly saved template won't necessarily appear in the Slide Design Task

Pane right

away. You can click Browse to locate it by its name, preview it, and apply it to a

new presentation.

So at this point, we have created a single multi-slide template with a
nice clean design that we can reuse or apply at any time to any number of
new presentations.
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You may or may not want to go to these lengths to fine-tune the Color
Schemes of your design templates—you may be happy creating one or
more clean templates that you can save in your own Templates folder,
back up, and then reuse for the different kinds of presentations you need
to create.

You can never go wrong with a clean white background design, and it
won't distract from your message.

Design guru Nancy Duarte steers her clients away from anything with
lots of red—saying that the audience usually can’t handle much of that
without getting edgy.

Rick Altman, who runs the PowerPoint LIVE conference and has writ-
ten extensively on slide design and other PowerPoint-related topics, calls
“black the chicken soup of PowerPoint backgrounds,” claiming that a tem-
plate with a black background and contrasting (white or light yellow) text
colors is acceptable in a multitude of settings and applications.

Of course, printing a set of slides with black backgrounds in a small
business setting can break the bank in laser toner. That’s why we will cover
design for printing Handouts later in this chapter.

But for now, we're at a point where we can create and apply a template
and understand the advantage of designing our own clean look over using
the products included with PowerPoint.

If you are creating templates for others, particularly if you are creating
a series of them for various types of presentations, you might find it helpful
to organize your main Templates folder into subfolders. Obviously, you can
do this by right-clicking the main folder and creating a newly named sub-
folder, just as we created a Desktop project folder in the previous chapter.

Because templates are valuable properties, I strongly suggest saving
them to multiple locations and backing them up religiously. If you really
think they’re valuable, and some definitely are, you can also assign a
password to open the templates and another to modify them by using the
Tools > Options > Security setting in the file, just as you would a normal
* PPT file.

Think back to Chapter 1 where we showed you the AutoContent Wiz-
ard; remember that there is another type of template—for content.

Just as the example we’ve been building in this chapter has multiple
slides, you can save a multi-slide template file not only to reuse the con-
cepts and language (as the AutoContent Wizard “Presentation Templates”
do) but also to maintain palettes of your best diagrams, charts, and even
linked videos in a set of template files. That’s something to think about as
we get into more sophisticated creation of visual elements.
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Understanding the Role of Masters

Earlier in this chapter, we mentioned the use of multiple Masters within a
single presentation to place a logo in different parts of the background for
different slides (refer to Figure 2-10).

With these multiple Masters created, any one or more of them can be
applied to one or more slides by selecting them in Slide Sorter view.

Most people use Masters in two ways:

= First, by putting the logo on the Master wherever you choose, you
can quickly customize a presentation by applying that master to var-
ious slides—they will all share that look.

= Then, by reformatting specific elements within the master, you can
quickly make a similar set of changes automatically within of lots of
slides at once.

Let’s see how and why that works.

As already mentioned, the Slide Master is essentially a blueprint for all
slides based on it. And it’s very powerful—imagine if in the real world you
could build some condos based on a blueprint, and then if you changed the
dimensions of the shower in the blueprint, the showers in all of the condos
automatically had their dimensions changed correspondingly!

If we click View > Slide Master and return to the three extra Masters
we created (but never applied) with the logos in different positions, we
should also see that their Title text color is still the blue we created origi-
nally—we never changed it to match our template using the custom Color
Scheme.

In fact, the Bullet text color is still the hideous black that came with the
original ugly white blank template. Remember, we simply created these
Masters using the Create New Master button on the Slide Master view
toolbar; only the first master has been applied to the actual three slides in
our design template presentation.

In Figure 2-19, we can see our current situation, with the third master
selected and visible in the preview window and its logo in the lower-left
corner.

So just for the heck of it, let’s work with this third master.

Let’s pretend that your Human Resources director insisted that any
slides dealing with his portion of the presentation needed a “totally differ-
ent look and feel.”
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FIGURE 2-19  In this Slide Master view, we have created three new Masters, one of which is
selected and previewed. Only the first master has actually been applied in the presentation
itself.

You know better than to lock horns with the HR person. Your paycheck
could get sent to Pago Pago.

So you go ahead and change the Title text color to a lighter lilac and the
Bullet text to a lighter green, both reflected in the logo and loyal to the
brand.

Then you use the Format > Background setting (in the Master view,
not in the Normal Slide view), to change the background of this master to a
dark gradient that resembles the older 35mm slides.

You select the Fill Effects in the Background panel and choose two
dark colors for a two-color gradient, as shown in Figure 2-20.
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FIGURE 2-20  Manually changing the design of one of the Masters will allow you to quickly

reformat a

set of slides based on the master.

When you click Apply (not Apply to All!), this one radically different
Master takes its place in your presentation in Slide Master view.

Just for good measure, let’s conform it to the other applied master by
giving it a solid light-colored line above the title and confining the bullet
area so that it is anchored in the grid to allow for more space around it (see
Figure 2-21).

Obviously, our users can always change its dimensions, but not if our
Human Resources Director publishes the specification in a policy manual
with the template!

So now if we click Close Master View, we can return to the presenta-
tion and add a new slide for Human Resources.

Notice in Slide Sorter view that it has the attributes of the main tem-
plate and the only master that has been applied so far, but all of the possi-
ble Masters are still visible in the Slide Design Task Pane.



02 Bunzel 02.gxd 8/28/06 4:36 PM Page 87 $

UNDERSTANDING THE ROLE OF MASTERS

87

[ Microsoft PowerPoint - [design.pot]

=1a[x]

Typeaquestionforhelp  + X

-lef
: slide Des

(B8] Fle Edit View Insert Format Tools SideShow Window PFCMedia Help Bresze arrow Duplcate Slde Master shadow2

 Arial cae-|B 7 U s [E|lE=EE]A A
gne.,d-ag! DEHRE GR(ZE| %6 90| @GS

TEENEERL IXRN KRR LERR KERr SERN KRS CRRN KRR EERN KERS CARN KARY TX2 XN

| A ~ | [=Design JNEWS\\dEMasEr!

%4.: 61%

-

[&l) Design Templates
(=} Color Schemes
[y Animation Schemes

Apply a design

|+ 1 |[& & | & 4

ll:}’l&'.

N
.
=
~
-
m
=
m
=
=
=
(2]
)
=
o
=
m
wv
2
(=]
=
>
-
o
m
=
(=]
=
)
=J
=
=
]
-
m
wv

£ Browse...

2

=
1_Custom Design e

Slide Master

FIGURE 2-21  The Master is refined to conform to the main template, with a solid line above
the title and a confined area for the bullets.

This is the situation in Figure 2-22, where we have selected our new
Human Resources slide in Slide Sorter view, and in the Slide Masters rep-
resenting the templates within our presentation in the Slide Design Task
Pane, we are about to apply the new master to Selected Slides.

TIP In this presentation, we have only one slide representing the Human
Resources Department. But if we had more, we could select them all by using
CTRL+click in Slide Sorter view.

When Apply to Selected Slides is clicked, the presentation is trans-
formed.

Now the Human Resources Department has its own unique look,
based on the newly revised master.
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FIGURE 2-22  Slide Sorter view allows us to apply a specific template (based on the Master)
to one or more selected slides.

If we return to Normal view, as shown in Figure 2-23, and add another
Human Resources slide directly after the one with the new Master, it has

the same attributes and is ready for revision.
Obviously, Masters are a powerful way to quickly reformat your pres-

entation.

WHEN DON'T MASTERS WORK? [f you have already specifically formatted
an area of a slide and then attempt to override it by applying a Master, the
affected area won't be revised according to the “blueprint.” You would need to
Reapply the Slide Layout to enforce the rules of the Master onto the slide (don't

ask me why).
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FIGURE 2-23  With a new master applied, slides created directly following it will take on its
characteristics.

Final Design Touches

To the extent that you have gone down the path of a professionally
designed set of templates for yourself or a client, you should note that your
decisions should affect a number of elements, some of which we’ve now
covered, and others that just make common sense.

Now that you understand Slide Masters, you realize that they are the
visual blueprints for all of your slides so that different Masters can be used
for different types of presentations. According to Nancy Duarte’s final
checklist, every Slide (and Title) master should conform to the guidelines
of the grid and anchor principles and should be checked for the correct
font.
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Here is a list of types of slides that are specifically designed in confor-
mance with the overall template look:

Title slide—walk in

Bullet slides—with and without subtitles
Two column

Quote and segue

Logo format

Graphic treatment (custom diagrams with shapes and accents)
Color palette (based on Color Scheme)
Chart style

Image, media, and/or video use

= Tables

= Grid system (design slide)

= Screenshots (for training)

But wait. For a completely branded look, you also need to pay atten-
tion to your Notes and Handout Masters. All the key elements need to be
present and formatted according to your design decisions, complementing
your brand or underlying your presentation template.

Before delivering a professional template, Duarte Design confirms the
RGB values in the Color Schemes, makes sure they're present in the cor-
rect area of the color palette, and deletes extraneous Color Schemes from
the template(s).

Duarte makes life easier for her clients by making changes to Power-
Points default settings, including turning off “Allow Fast Saves.” You
should examine your own default option settings to see how well they fit
your work flow.

Then of course, they test the template by running it in Slide Show
mode and check all print versions for glitches. The actual presentation
needs to be legible when projected, and you probably need to keep your
fingers crossed if you want a given projector to faithfully reproduce your
carefully designed and branded colors.

If this is a big issue for you, check the setup hints in Chapter 8, “Deliv-
ering a Killer Presentation.”

Hopefully, your logo and text will be sharp, clear, and legible whenever
and wherever projected.
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Losing the Extraneous Placeholders

We didn’t really cover the other little placeholders in the Slide Master:

= Date and time
= Footer
= Slide number

What you need to remember is that these placeholders are only there
to format these items (if you even want them in your slides).

To actually place information into these placeholders, you need to
enter it by using View > Header and Footer.

If you want clean-looking slides, you can leave the areas blank, and if
you like, you can also select and delete (press Delete) the placeholders
from the Slide Master.

But what about the Bullet placeholder?

If you delete the Bullet placeholder from the Slide Master, can you
somehow entice your users or inspire the creators of slides based on the
cleaner Masters to use bullets wisely, if at all?

Sorry.

Any new slides based on the master will always have the default Title
and Bullet Layout.

You need to talk to the Human Resources person and create a set of
policies and recommendations that will enforce or inspire a policy against
populating your slide shows with too many bullets or Title and Bullet
slides.

The only sure way to eradicate bullets from a slide is to give it a clean
Layout—Title only or blank. Generally, the Slide Layout Task Pane opens
for every new slide you create by default; if it’s not open, press CTRL+F1
to open it quickly, and (re)apply a Title only or blank layout to your slide, as
shown in Figure 2-24.

Unfortunately, this is the only way to really get rid of the Bullet place-
holder in your newly created slides.
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E2-24 The only way to get rid of the blank Bullets placeholder is to (re)apply a dif-
t slide layout from the Slide Layout Task Pane.

What About Fonts?

Remember the two resources mentioned earlier for design? When I want
to work with fonts, I go back to information that I have learned from
attending sessions given by Julie Terberg, a frequent contributor to Presen-
tations Magazine.

She divides fonts up into five families (no, not those kinds of families).

Serif fonts are considered very business-like and studious—they're the
ones that have little extra design elements (or serifs) at the end of the let-
ters. They originally came from the type or print world, and they don't
always project very well.

Because we've been talking about creating a clean or more modern-
looking design for our presentations, the fonts we might want to concen-
trate on are the sans serif family (without the design elements, hence
cleaner). The good news is that these are also more legible than serif fonts,
and as Julie says, “Many professionals consider sans serif fonts to be the
best choice for presentation design.”

o
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Script fonts, or those resembling handwriting, are a better choice for
special effects. Symbol fonts include elements not found in the common
alphabet and are sometimes good for special bullets. Display fonts are sim-
ilar to the WordArt styles, and if you were to design an entire presentation
using them, you'd be lucky if the audience just walked out and didn’t mur-
der you.

In terms of digital fonts, there are Type 1 (or Postscript) fonts available
for higher-end printing, but you really want to stick with the Windows
TrueType fonts for PowerPoint and other types of projected presentations.

A rule of thumb is that the farther afield you go in terms of creative
fonts, the more trouble you may get into. Besides the design issue, if you
download and use an esoteric font and forget to embed it with the presen-
tation, if the file is moved to a machine where that font is not registered,
you can have a nightmare on your hands just before you go on. (See the Tip
about using Replace Fonts and Adobe Type Manager later in this chapter.)

Figure 2-25 gives you some idea of the representative fonts available in
PowerPoint in the Five Font Families.
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FIGURE 2-25  Julie Terberg’s concept of the Five Font Families can help you choose the cor-
rect one for your presentation or make appropriate substitutions.

Be careful about using lots of different fonts. It’s one of the best ways
to really annoy an audience because lots of different and weird fonts can
make a presentation illegible on the screen and hard to follow.

Having said that, additional fonts are available in MS Publisher, which
is now part of many versions of MS Office.

NOTE Additional information about TrueType fonts along with an extensive
font library is available at Microsoft Typography (http://www.microsoft.com/
typography/default.mspx).

Another source for fonts is http://www.fontgarden.com.

Finally, you can use Google or any Internet search tool to locate more fonts
with which to muck up your presentations.

o
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To install a new font, just open Fonts in Control Panel, click the File
menu, and choose Install New Font. If you downloaded it, browse to the
drive and folder location and add the font to those already loaded on your
system.

To figure out just which fonts are currently in use in a given presenta-
tion and modify them if necessary, just choose File > Properties > Con-
tents (see Figure 2-26).

widgets.ppt Properties i i x|

General I Summary I Statistics  Contents |Custnm |

g:’:t‘;"r“;”:t Fonts Used
Times New Roman
Wingdings 2
Design Template
blank
Slide Titles
The Case for Widgets
Why We're Doomed Without Widgets
The Incredible Benefits of Widgets
How We Can Easily Use Widgets
Call to Action: Commit to a Widget Strateg
Why We're Doomed Without Widgets
The Incredible Benefits of Widgets
How We Can Easily Use Widgets
Call to Action: Commit to a Widget Strateg

cos

FIGURE 2-26 The Contents panel of Slide Properties lets you see the fonts in your presenta-
tion, as well as slide titles and design templates.

TIP A simple Replace Fonts dialog box is also available under the Format menu
in PowerPoint that lets you quickly substitute one TrueType font for another
throughout your presentation. Presentation professionals who work in “speaker-
ready” situations at big events and need more functionality over lots of different
fonts that may cause problems use ATM (Adobe Type Manager). This tool can
help even if a troublesome “2” appears in the Replace Fonts dialog box by allow-
ing you to quickly substitute an alternative font for a missing one.
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Designing for Handouts

Although we will cover the strategies and techniques involved in printing
Handouts (and Notes) in Chapter 8, we can and should start to think about
these issues in the design phase.

Many of us are printer-challenged; we can't all go to Kinko’s or down
the hall to a high-speed color printer that will do full-color justice to our
PowerPoint masterpieces.

Anticipating the device on which our slides, whether as Handouts or
combined with notes pages, will be reproduced on paper is a good design
concept to bear in mind from the outset of our presentation planning.

For this reason alone, I would submit that the clean and simple look is
preferable for a professional presentation.

In the event that you require a colored background or more significant
graphics as part of your overall design, your best bet is to fine-tune some of
your main graphics objects in the event that you need to print in either
grayscale or black and white.

Two levels of refinement are possible when converting color to
grayscale or pure black and white. First, under the PowerPoint View
menu, you can instantly transform the current version of your presentation
to any of these modes by selecting View > Color/Grayscale.

Then, in any of these modes, you can right-click a graphical object that
you intend to use in the presentation and whose design you want to faith-
fully preserve in the printed Handouts, as shown in Figure 2-27.

Then copy this object for use in the grayscale/handout version of the
presentation.

Tweaking the grayscale or black and white settings will be of particular
importance if you have chosen a darker (black) background for your slides
and want to make sure that more subtle graphical objects are visible in
your Handouts.

Going in the other direction, if you know going forward that you will
need subtle diagrams in your slides, and they are destined for Handouts,
you may want to avoid darker backgrounds and continue to choose cleaner
slide designs.

Finally, if your logo will be appearing on all slides using the Slide Mas-
ter, make sure that it is optimized for printing, and take care to ensure that
other graphics and text are not covering up the logo.

This goes back to the grid system suggested by Nancy Duarte and the
corresponding choices for placing a logo in the most remote corner of the
set of slides with which you will be working.
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FIGURE 2-27

If you need to print in black and white or grayscale, you can fine-tune your

graphics objects to optimize them for Handouts or notes.

Obviously, you can construct one slide set for presentation and another
for printing and plan for that from the outset, but coordinating them and
making sure that each is synchronized for the latest content may become a
challenge.

Considering the ramifications of your design decisions in the planning
and design phases can only help in terms of ensuring that both your
onscreen and paper versions of the presentations do justice to your mes-
sage and show you in the best possible light.

Using Third-Party Design Tools

There are so many resources for PowerPoint designers online and for pur-
chase on disc that it would be impossible to list them all here. Font and
design specialist Julie Terberg has a bunch of design-related resource sites
linked at her site (www.terbergdesign.com).

o
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Prepackaged templates are available all over the place, beginning at
Microsoft’s Assistance Center. The advantage to these is that they are true
* POT template files that when applied will overwrite your other format-
ting decisions as Slide Masters in the manner previously described.

Other “PowerPoint templates” are merely nice designs or images. You
need to be aware that some of these just put a design into the main slide,
while others are savvy enough to put it on a Background. In many cases, if
such a picture is all that is supplied, there are no color-coordinated fonts or
other elements included, and you will need to re-create them using the
principles of the Slide Master.

Then there are companies that offer comprehensive solutions includ-
ing extra clip media (video and animations) in complete design packages.
These include

= Crystal Graphics—www.crystalgraphics.com
= Digital Juice—www.digitaljuice.com
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We'll talk a lot more about using stock photographic images in our
slides to communicate ideas and make analogies in Chapter 3, “Creating
Dynamic Visuals,” but if you want use an image for a customized template,
there are two things to keep in mind.

If you put an image on the Slide Master (where it obviously ought to be
in order to serve as a background on one or more slides), it is likely to over-
whelm the other content that will be added to the slides themselves.

When you insert such an image, as we’ll see in the case study at the end
of the chapter, you can alter its transparency and then use the Order >
Send to Back command on the Drawing toolbar to ensure that the other
placeholders remain on the Slide Master and can be formatted in a manner
complementary to the image itself.

A good source of templates will do all of this for you. Some that you
download may not, so you should be aware of the distinction, and now you
have the tools to make the necessary adjustments using Slide Master view
in PowerPoint before re-saving the entire package as a template.

Dramatic 3D Animated Designs with OfficeFX

If you explore some of the offerings from Crystal Graphics, they have some
animated video backgrounds that will dramatically change the look of your
presentation.
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But the company that is probably leading the way in this arena is
Instant Effects, which publishes the OfficeFX Add-On for PowerPoint.

OfficeFX is probably best employed in scenarios where you have a dra-
matic live event, perhaps even with multiple screens. Users of this software
have included some of the major automotive and pharmaceutical compa-
nies. Essentially, OfficeFX takes your PowerPoint design and transforms it
into a real-time photorealistic 3D background, with motion graphics and
3D objects that you can move and turn as you present.

Using the toolbar that appears when you install OfficeFX, you can
choose from an entirely new gallery of 3D backgrounds and instantly apply
them to your slide show. It’s an instant design transformation, taking an
ordinary set of bullets and putting them into an entirely new environment,
like the seascape shown in Figure 2-28, complete with a swimming dolphin
and newly shaped bullets.

Issues to Consider

~ Potential conflicts
~ OfficeFX and Apreso require a Registry fix to co-exist

~ Breeze requires a web subscription for full
functionality but can be use-—-‘ {to import Flash

files — \"\\

" —"— -
>~ Make sure your solutiurg.._. ... PowerPoint
features your message reguires

~ Example —te capture Crystal Graphics video backgrounds
_ -use Camtasia.Full Segeen main capture and nowthe
= PowerPoint, G ' =2

FIGURE 2-28  OfficeFX can instantly give your presentation a dramatic animated 3D design
with motion graphics and moving objects.
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It all takes place within the OfficeFX tabbed menu, where you first
choose a theme from a gallery and then fine-tune it to work with your cur-
rent content: titles, bullets, and graphical elements. Going slide by slide,
you make subtle adjustment to the implementation of the theme as you
move through your presentation, as shown in Figure 2-29.
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FIGURE 2-29  The OfficeFX menu lets you apply a theme and fine-tune its implementation
throughout your presentation, either changing or preserving your text and graphics.

As of the time of writing, OfficeFX recognizes

= Drawing order of all content

= Text fonts, sizes, placement, colors, and bullets

= Content transparency, color, line effects, and bit map inclusion

= Custom animation effects, triggers, and timings for all content and
media (with some limitations for Effect Options—currently with
respect to sequentially introducing PowerPoint diagrams and
charts)
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= Audio and video

Hyperlinks (within the same PowerPoint file—not externally)

= Slide Masters and Backgrounds (alternately with its own themes,
which you determine within the interface)

= Auto Advance slide timings and Kiosk mode

By using the Colors tab of the Options panel, you can decide whether
the color you've chosen in PowerPoint or the FXTheme will control the
appearance of elements like text, shape fills, and lines.

3D objects created in Autodesk 3D Studio Max can also be imported
into OfficeFX slides and manipulated in real time (see Figure 2-30).

'EZ Microsoft PowerPoint - [FXNot Your Mama's PowerPoint.ppt] 7 T _[&] X!
(3] Fle Edt Vew [nsert Format Tools SideShow Window Help Breeze amow Duplicate Side shadow2 Typeaquestonforhelp  » X
Al -8 -|B 2z USs|[EE=EEE A A - | & Desion jMewEhda
NEHRRGSR YR $DB 90 BEHEE Erza -af
_\“ B D EEMELHVOI[t >
x|
>
* Side Var Themes | Varitions | Options Insert. | Publish | Prefs | =
s 1 Not Your Mamas... A =
4 2 Progemsto Cons.| A Scene 1| Scene 2| Video | ==
C 3 lssuesto Consider | A
4 Benefis for Press... A Scens [ogo WoS
+ 5 Video Best Practi.. | A
= 6 <Urtiled> A Version: [WoS_With Sphere -
Placement:  Center | Maximize |  Reset
Offset H: P00 = v oo =]
3
Sire: |
) H &
O Design @ Inleractive I7 Interactive o5
I lanore Transitions -
I™ Clear Backaround
Variation: default Place Behind PowerFoint Content
i e L ERER)
Slide: 6 <Untitled> o
Theme: Seafloar & Animate Continuously (L [
€ Start Animation en Click
€ Start Arimation on Slide Display
GiesieSiangn | Remove From Current |
Assign ToAl | Remove Frem All_|
« | = ok | coca |
S [TexTanTTonent Layouts
Click to add notes
I show when inserting new slides
Esz i -
?DLEW'\AumShapES' NwOCEHAdSRR S-Z2-A-==c @ ﬂ!
Slide 6 of 6 Edge 103

FIGURE 2-30 3D objects created in 3D Studio can be imported into and manipulated in
OfficeFX slides.

OfficeFX also really shines with video, which we will cover in greater
detail in Chapter 5, “Using Video and Audio Effectively.”

But it’s worth noting that OfficeFX can map video onto 3D objects and
import and export video files as part of its functionality in the Publish tab.
A video mapped onto a 3D object is shown in Figure 2-31.

o
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FiGure 2-31

OfficeFX can map video onto objects as they display in your slide.

Essentially, OfficeFX takes PowerPoint into the production or broad-
cast arena—printing slides is probably less important to an OfficeFX user
than outputting them to video and perhaps posting the video to a web
server.

Using the program is obviously an important initial design decision—
for one thing, using OfficeFX at a show does require some preparation in
terms of hardware. You will need a very powerful graphics card (64MB of
video RAM is the minimum recommended) and some other software mod-
ifications. More and more laptops are being released that are OfficeFX
ready.

It also involves something of a learning curve. Although the menu is
straightforward, getting the graphics to perform just the way you want will
take you a bit beyond ordinary PowerPoint.

The complete set of OfficeFX hardware and software requirements as
well as purchase options and other information can be found at
http://www.instanteffects.com.

Here are two things to keep in mind when using OfficeFX:

= Save your OfficeFX presentation within the OfficeFX menu as a
separate file.

= Practice presenting from within OfficeFX to take advantage of its
capabilities.
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You can maintain a prior version of the unaltered PowerPoint presen-
tation to return to in the event that you do not want to use OfficeFX’s
design decisions later on.

Looking Ahead: PowerPoint 2007

By the time this book is published, a new version of PowerPoint will be
available, and some of you may be either using it already or contemplating
its adoption. Based on the beta version available at the time this was writ-
ten, there were several design elements in the new version that are worth
noting in terms of producing clean and dynamic presentations.

New Layouts: Setting a Default

The Layout area for new slides has been dramatically streamlined, and
perhaps the best news is that creating a new slide will no longer necessitate
beginning with a Title and Bullets layout with bullet placeholders.

You can select any layout as a new default, and it will be applied to your
new slides, or you can create your own layout to add to the layout gallery
and use in subsequent slides.

In Figure 2-32, you can see that a simple Title only layout has been
selected in the Layout gallery and is now the default layout for all subse-
quent slides added to the presentation.

Themes and Colors Enhance Design Templates

Although PowerPoint 2007 will support the older design templates that
came with previous versions, and the Color Scheme scenario just
described still holds, the central design element for formatting groups of
slides is now called a Theme.

Themes are composed of design choices, many of them much nicer
and cleaner than the older design templates, colors, and effects. Like the
older Design Templates, the new PowerPoint Theme puts an entirely new
look onto selected slides, but instead of overpowering them with lots of dif-
ferent graphics and backgrounds, themes appear to be more subtle and
clean, as shown in Figure 2-33.
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FIGURE 2-32  Any layout, even one you create and save, can become the default for new
slides in PowerPoint 2007.
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FIGURE 2-33  PowerPoint design decisions in Office2007 will be centered on Themes,
which are collections of fonts, colors, effects, and backgrounds that provide a cleaner, more
polished look.
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New Screen Reading Fonts: Calibri and Cambria

As part of the move to cleaner, more professional-looking slides that can be
instantly implemented, PowerPoint 2007 has new screen-friendly fonts,
including Calibri and Cambria. In most cases, these are part of the existing
themes in PowerPoint 2007, but as you create your own designs and
themes, using these fonts should improve the clarity and readability of your
slides. You will find the new fonts in the Font panel of the new user inter-
face, as shown in Figure 2-34, and you can apply them and save them with
a theme that you create on your own.
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FIGURE 2-34  PowerPoint 2007’s new screen-friendly fonts like Calibri and Cambria are
designed to enhance the readability of slides when projected or viewed on a computer

screen.

Turn Bullets to Graphics Instantly

Although we're going to cover the creation of dynamic visuals in the next
chapter, it's worth mentioning here that PowerPoint 2007 enables this
technique within its new interface by allowing the user to quickly turn a set
of written bullets into a corresponding SmartArt graphic or diagram.
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Opening the new diagram gallery with bullets selected can instantly turn
the bullet text into any of a host of new diagrams, including Venn diagram,
as shown in Figure 2-35.
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FIGURE 2-35 PowerPoint 2007 encourages the use of visual analogies by allowing the user
to transform ordinary bullets into corresponding diagrams from a new gallery.

Use Enhanced Design Effects

Although making a diagram or set of graphics stand out in a professional
way with high-end 3D effects or shadows used to involve third-party tools,
the new Effects galleries in PowerPoint allow the user to apply glow
and bevel effects to the diagrams or graphics they create, as shown in
Figure 2-36.

Many of the design techniques that we will cover in the next chapter
will be streamlined and enabled in a much easier way in PowerPoint 2007.
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FIGURE 2-36  PowerPoint 2007 has a gallery of new effects including glows, shadows, and
bevels that can be fine-tuned, saved, and instantly previewed and applied to new diagrams
and graphical objects.

Case Study: Creating Design Templates for a Travel
Agency

You are the presentation specialist for a large web conglomerate that has
just acquired TravelTime, a full-service travel agency. As part of the acqui-
sition, there will be any number of presentations to be developed for the
top executives to take on a road show, for human resources managers to
use in training the in-house staff, and for sales and marketing to use as they
visit vendors.

The TravelTime executives who have been absorbed into the conglom-
erate come for their first visit to your office and bring with them the Trav-
elTime presentation template, which they have been using for a while, as
shown in Figure 2-37.

They're excited because they've figured out how to put the picture into
a rectangle AutoShape and reduce its transparency.

“See, it doesn’t really overwhelm the whole slide,” the President of
TravelTime says. “What do you think?”

o
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FIGURE 2-37 A common PowerPoint template would use a picture in the background of the
text placeholders.

Before you respond, here is the new corporate logo for TravelTime
that your major advertising firm has designed (see Figure 2-38).

FIGURe 2-38  This more professional-looking logo is what should be used in the new pres-
entation templates.

o
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What might your response be in this situation?
Think about it before you begin reading the next section.

Key Issues to Consider

You might respond as follows:

= Have we reviewed the overall website of our company?

= We've been asked to redesign the template to fit within our overall
brand without compromising your identity.

= We've actually invested some time with a high-power marketing
firm to redesign your logo and rethink the brand.

= Why don't you let us work with the elements we have and see what
we come up with?

The executives aren’t entirely sure, but they're new in the company after
all, so they’re will to see what develops. Before they leave, you show them
the new corporate logo that the advertising agency has designed (refer to
Figure 2-38), and they're impressed. You tell them that you'll provide some
new branded templates for their division in a week.

The first thing you need to do is to load the logo TIF file into an image
editing program and analyze some of the key colors, using the color picker
to determine their RGB values:

= The dark brown from the spyglass has an RGB of 93 51 29.
= A darker blue from the map is 94 123 139.
= The gold from the globe and spyglass is 140 116 82.

Then you resize the logo to fit into a slide set so that it won't be over-
whelmed. You do this in the image editing program by taking the width
and height dimensions down to 15% of their original size and maintaining
the original aspect ratio. (The aspect ratio of an image is the relationship
between its height and width. If one of these dimensions is altered without
a corresponding change to the other to keep the ratio constant, the image
becomes distorted. Better image editing programs have settings when you
are changing dimensions to keep the aspect ratio constant.)

In a blank white slide, you enter the Slide Master view and resize the
Title and Bullet placeholders so that they fit into a smaller area to increase
the white space. You remove the footer, slide number, and date placehold-
ers and line up the title and bullet placeholders by using the Align Left

o
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command under the Order panel of the Draw button of the Drawing tool-
bar (see Figure 2-39).
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FIGURE 2-39  Clean up the Slide Master by creating and realigning smaller placeholders
and removing extraneous placeholders.

Thinking about the logo and its placement for the corporate executive
template, you decide to offset it with a thick blue vertical bar. You keep the
dark line color but change the Fill color of the bar to be identical to the
blue that you selected out of the corporate logo, as shown in Figure 2-40.

Now you bring in the resized logo TIF image by clicking Insert > Pic-
ture from File (still in the Slide Master view) and line it up with the col-
ored bar as shown in Figure 2-41.
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FiIGURE 2-40 Use the Custom Colors tab of the Fill color tool to match the RGB values of the
corporate logo.
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FIGURE 2-41  Inserting the logo into the Slide Master will make it part of the uniform look in
the template.
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For the Title and Bullet text color, you once again use the Custom tab,
this time in the Text Color tool, to match the dark brown from the logo.
See Figure 2-42.
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FIGURE 2-42  Refine the text colors in the new template according to the color values
of the logo.

You add a Title Master and make it unique by extending the vertical
bar all the way to the bottom and adding a larger version of the logo in
another part of the slide, resizing the placeholders once again within the
grid to allow for more white space, as shown in Figure 2-43.

After leaving the Slide Master and checking the results with a new
slide, you enter the Color Schemes Task Pane and use the Custom Color
Tab to apply logo-centric colors to other elements in a new Custom Color
Scheme based on the slide, including Text and Line colors, Title colors,
and Accents, as shown in Figure 2-44.
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FIGURE 2-43 A unique Title Master can make use of a larger version of the logo and
slightly different configuration of the same elements.
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FIGURE 2-44 A new custom Color Scheme will let you use the specific RGB color values for
the various slide elements.
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Then you exit the Options panel and make sure that you apply the new
Custom Color Scheme to all of the slides in the presentation you just cre-
ated. To round out the set, you add a Quote Slide (without a title) and for-
mat the quote box and author reference to coordinate with the template, as
shown in Figure 2-45.
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FIGURE 2-45  Different types of slides like a quote slide will adopt the look of the Color
Scheme; but they can also be individually refined for their respective types of content.

Just to be sure, you change a layout in a slide for a chart and open a
generic column chart to see how it reflects the overall design and look. It
looks like Figure 2-46.

Then you save the new presentation as a template file. And then you
make slight modifications in the template for HR and sales (see Figure 2-
47), saving each as a different template (*.POT) file.

When you bring back the TravelTime executives and present the new
templates, they have the usual comments but can see that the new clean
look will work as part of their new corporate structure, and they agree to
implement the design throughout the new division of the conglomerate.
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FIGURE 2-46  With the custom Color Scheme applied, all charts and diagrams will also
reflect the overall design decisions.
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FiGure 2-47  With some modification, different branches of the company can have their
own design looks within the overall brand.
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SUMMARY 115

Only one issue may remain: The size of the logo on certain slides may
overwhelm the use of images and pictures to tell a story. You agree to make
a special picture and diagram slide within the template for the various divi-
sions, where only the solid bars are present, to accentuate any use of
images. We'll see how that might work in the next chapter.

Summary

Because such a great part of a successful presentation is its visual effective-
ness, in this chapter we picked the brains of some design experts and
applied their concepts in PowerPoint and some related programs.

Not everyone has a professional eye, and that’s why we analyzed the
concepts of using space and branding and created a different template for
different corporate divisions and objectives.

Colors are a key component in any design, and we need to understand
the various parts of the Slide Design Task Pane, including Design Tem-
plates and Color Schemes, and how they interrelate to design properly. We
also saw how multiple Masters could help us differentiate parts of our pres-
entation and reformat sections automatically.

The main elements of creating an effective design include
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Thinking like a designer

Implementing a brand strategy

Using Color Schemes to fine-tune color choices
Saving designs as Design Template files
Choosing simple and effective fonts

We also covered the essential aspects of designing for Handouts and
mentioned some third-party design tools. We noted that many design
changes will be on the horizon in the next version of PowerPoint and pro-
vided a brief preview of some of them.

Now it’s time to move from the overall look of the presentation to the
individual message components and begin the really worthwhile task of
creating individual slides and concepts that visually communicate our most
important ideas.
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116 CHAPTER 2 IMPLEMENTING PROFESSIONAL DESIGN PRINCIPLES

Resources

There is an entire industry devoted to supplementing PowerPoint, and a
lot of it is geared to the overall design process. We sprinkled most of the
major players in the field throughout the text of the chapter, but here are
some other resources that will enable you to manage design elements (like
pictures) and your visual elements more effectively.

= Ulead PhotoAlbum—http://www.ulead.com (part of PhotoImpact
package)

= ThumbsPlus—http://www.cerious.com

= Desktop Search—Copernic—http://www.copernic.com/

= http://www.visualthesaurus.com/

= Canto Cumulus—http://www.canto.com/

= Presentation Librarian—http://wvww.accent-technologies.com/



